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Introduction

MicroWorlds EX is the latest in a wonderful line of products used by millions of children
(and adults) around the world. With it, you and your students can construct, design,
produce, present, animate, analyze, integrate, visualize and, most importantly, explore
ideas. How can one piece of software do so much? MicroWorlds EX is not a tool, but rather
a collection of tools assembled to provide the means you need to do all the types of
explorations you can imagine. By  tools, we don’t mean just gizmos and gadgets (although
there are definitely some of those in MicroWorlds EX) – we’re referring to a language that
encourages children to talk about their ideas, their questions, and their strategies for
finding answers and a deeper understanding.

Components

The MicroWorlds EX package comes with a set of materials, both print and digital, to let you
and your class start exploring quickly. There are different starting points, depending on the
level of MicroWorlds knowledge you and your students have or the types of activities you
want to do.

The main package components for MicroWorlds EX are:

• The MicroWorlds EX CD containing the MicroWorlds EX program plus additional files
listed below

• This Teacher’s Getting Started Guide

• MicroWorlds EX Projects Book

The following learning and reference materials are included in the MicroWorlds EX program:

• MicroWorlds EX Tutorials

• Techniques

• Samples 

• Importable Turtle Samples

• Basic and Advanced (Comprehensive) Reference Guide (Help)
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The following additional files are included on the CD for use with the MicroWorlds EX program:

• Music, Sound, and Picture Folders 

• Read Me First!

The MicroWorlds EX CD also contains pdf versions of the following:

• Tutorials

• Teacher’s Getting Started Guide

• MicroWorlds EX Projects book

The MicroWorlds EX Robotics package also includes:

•  RCX Projects Book

•  Crickets Project Book

Installation

Installation instructions are included on the CD case insert that comes with your CD. Do
not forget to read the Read Me First! file on the CD. This contains information to help with 
the installation. 

The installation instructions are also available at
http://www.microworlds.com/support/ts.html.



Getting Started - Macintosh

Welcome Screen

Start by installing MicroWorlds EX. By default, MicroWorlds EX is configured to display the
Welcome Screen at startup. You will recognize this mode by the presence of the following
Welcome Screen:

If the Welcome Screen has been turned off, then starting MicroWorlds leads directly to a
blank, new project.  If you would like the Welcome Screen to appear at startup:

1- First, display the Welcome Screen by clicking on the first button on the left in the
toolbar above the MicroWorlds EX page:

2- Next, uncheck the box labeled "Do not show this screen…" at the bottom of the
Welcome Screen. The next time you start MicroWorlds EX, the Welcome screen will be
displayed. 
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Setting up MicroWorlds for your Robotics Kit

If you are using MicroWorlds EX Robotics, you may have to set some "preferences" before
you start. 

Please read the special instructions pertaining to robotics in the ReadMe file (on your CD
and in the folder where MicroWords EX was installed), and refer to the robotics online Help
system (choose Robotics in the Help menu).

The ReadMe describes the installation procedure and the online Help tells you how to set
up the Preferences in MicroWorlds EX Robotics in accordance with the robotics kit that you
are using.
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I’m New to MicroWorlds. Where Do I Start?

If you and/or your students have never used one of the MicroWorlds products before, it’s
best to start at the beginning! Begin by looking at several of the Samples to see what is
possible to do. Don’t be afraid to look through everything and make changes. The Samples
themselves are write-protected, so you won’t erase or change them. If you do want to save
a version of the Sample that you’ve changed, save it under a new name.

The Samples show the range of explorations you can do with MicroWorlds EX. 

Next, begin to create your own projects using the Tutorials as a guide. Start with either A
One-Page Presentation or A Simple Animation (or both). Then continue with Turtles and
Geometry. Although the Tutorials do not have to be completed in order, the latter ones do
assume more programming knowledge.

MicroWorlds EX Robotics includes additional Tutorials that introduce the robotics features
and primitives as students create their first robotics projects.  

My Students Have Used MicroWorlds Before. Where Do I Start?

If your students have used earlier versions of MicroWorlds, such as MicroWorlds 2.0 or
MicroWorlds Pro, a good starting point is the more advanced Tutorials (Music Turtle, E-
Cards, Horse Race, Modeling, or Quiz-Maker). Many new MicroWorlds EX features are
introduced in these activities. 



The most significant new features in MicroWorlds EX (listed along with the appropriate
Section and Topic in the Advanced Reference Guide) are:

• Turtle backpacks (Turtles (Basic) - Creating a Turtle; Introducing the Backpack and Turtles
(More About Backpacks) - All topics in this section)

• Exportable turtles (Turtles (Basic) - Exporting, Importing, and Mailing Turtles)

• Public versus Private Shapes, Procedures, Rules (Turtles (Shapes) -  About Private and Public
Shapes and Using Private and Public Shapes; Turtles (More About Backpacks) - Rules Tab –
OnColor; Programming Environment - About Private and Public Procedures)

• Clipart Library (Overview – The Painting/Clipart Palette; Graphics and Background Images –
Dropping Clipart on a Page)

• Wallpaper (Graphics and Background Images – The Wallpaper)

• Choosers (Choosers – All topics in this section)

• User-created Dialog boxes (Dialog Boxes – All topics in this section)

And, for purchasers of  MicroWorlds EX Robotics 

• Robotics – See the Robotics Reference Guide, listed in the Help menu

You may choose to have your students start with the MicroWorlds EX Projects book. Before
beginning the Projects book, students should have a good grasp of the MicroWorlds EX
features, primitives and concepts introduced in the Tutorials. (See chart on page 7.)

My Students Have Completed the Tutorials. What’s Next?

Once your students have completed all or most of the Tutorials, they are ready to try the
projects in the MicroWorlds EX Projects book. These projects are more elaborate than those
introduced in the tutorials and will most likely take students three or more sessions
(depending on the length of the sessions) to complete. These projects are meant to not only
increase the students’ MicroWorlds EX skills, but to also show students some of the different
types of projects they can create. Students should not rush through the project – there is a
great deal of room for personalizing.

You may duplicate as many copies of a project as you need for your students.The MicroWorlds EX
Projects book is available in pdf format at www.microworlds.com/support/documentation.html. 
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MicroWorlds EX features, primitives, and concepts introduced in the Tutorials include:

Title User Interface Features Primitives Concepts
One-Page Text boxes Page

Presentation Stamping floating graphics
Fonts
Transparent text
Painting tools
Clipart library
Video object
Music object in project
Presentation mode

Animated Scene Text boxes, fonts forward, fd Turtles
Hatch a turtle wait Backpack, Shapes tab
Painting tools Simple gliding animation 
Turtle shapes
Animate
Sound object in project

Turtles and Buttons cg Procedures
Geometry to, end Sub-procedures

right, rt Backpack, State tab 
back, bk Return to starting state (360o)
repeat Many Times ( button)
left, lt Pu, pd states

Music turtle OnColor instructions Interactive background (private)
Melody editor Name of object as command
Notepad Exporting turtle
Music object in backpack

Create an E-Card Import music forever Flipbook animation 
Melody editor launch Emailing a turtle
Record message setbg
Embedding music into turtle setpos
seth
announce

The Horse Race Name a turtle random Messaging
OnMessage broadcast Randomness
Buttons announce Animation with commands

turtlesown Turtlesown variables/
everyone dynamic primitives
setsh clickon/clickoff

Modeling Siders infix math Object names as reporters
Drop down list object if Conditionals
Set text box as variable Controllers/interactivity

Quiz-Maker Round button set nextpage Page names as commands
Wallpaper question Startup procedure
Duplicate page answer Conditionals

sentence
show
startup

Although some of these concepts are reviewed in the first project in the Projects book, the level of
discussion in the Projects book assumes that students are familiar with all these concepts and features.



Tutorials and Samples

The Tutorials use a project-building approach to introduce you to the various MicroWorlds
EX features. They provide step-by-step instructions for a variety of introductory and
intermediate projects. Samples contains completed projects that you can de-construct in
order to learn more about using the many tools in MicroWorlds EX. It is a good idea to
start with either one of these sets of materials. 

The goal of the Tutorials is to introduce students to MicroWorlds EX’s tools while creating
curriculum-linked projects. The Welcome Screen displays the list of all the Tutorials, listing
them from the simplest to the more complex. Although it is not necessary to complete all
the Tutorials in order, it is advisable to begin with one of the first two in order to
understand how the top-level tools work. We suggest that you read all Tutorials (trying
them is even better!) to determine which ones suit your classroom needs.  

Each Tutorial may take one or more sessions to complete. Once students have completed a
Tutorial, they may want to try creating similar projects independently. One approach is to
have students complete a Tutorial, then spend a session or two developing a project using
the skills they’ve recently acquired. If a student cannot remember how a specific technique
works, he or she can either re-open the Tutorial and find the appropriate step, or check in
the Techniques window in the lower part of the screen.
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To access the Samples:

In the Welcome Screen, click on Samples to get the list of available Samples. An iconic
menu appears in the scrollable area to the right of the Sample button.

To access Tutorials:

In the Welcome Screen, click on Tutorials to get a list of Tutorials. 
An iconic menu appears in a scrollable area to the right of the Tutorials button. 

Using the Tutorials

When you start a Tutorial, MicroWorlds EX starts a new, blank project, smaller than a 
normal project. On the left side of the screen, there is a list of Steps for the Tutorial. 
Click on each Step to display the instructions.

Once you’ve completed a Step, click on the Table of Contents icon to move back to the list 
of Steps.

Saving and Reopening your Tutorial Project

The project you create while working on a Tutorial is a regular MicroWorlds EX project. This
means you can save your project as you would any other MicroWorlds EX project. If you
have not completed the Tutorial and you want to continue working with it later, save your
project. When you want to start working on the project again, you must:

• restart MicroWorlds EX, 

• restart the same tutorial from the Welcome screen, and,

• while the Tutorial is displayed, reopen your SAVED project using Open Project from 
the File menu.



Using the Samples

The first page of each Sample contains some instructions about what you should look for and try. 

Samples are normal MicroWorlds EX projects, but the files are write-protected so they remain
intact. In other words, when you make changes to a Sample and try to close it or quit
MicroWorlds EX, you are asked if you want to save the changes that you have made. If you
wish to save the changes, you must find a different location to save  your project. Note that
this becomes your own personal project, not a modified sample. The next time you choose the
same Sample from the Welcome screen, the original, unmodified Sample opens. If you want to
retrieve your modified project, choose Open Project from the Toolbar, the File menu, or the
Welcome Screen.

Importable Turtle Samples

Once students are somewhat familiar with MicroWorlds EX, they may be interested in looking at a
second type of sample provided with the program – Importable Turtles. These are turtles that are
completely self-contained and can be exported from one project and imported into another. 

To access the Importable Turtle Samples 

1- Choose Import Turtle in the File menu AND use the browser dialog to locate the Turtles
folder in the MicroWorlds EX program folder. Click on one of the .mwa files and select
Open. A turtle appears in your current project. 

2- Drag a turtle (a .mwa file) directly from the desktop into an open MicroWorlds EX project.
Right-click/Ctrl-click on the turtle and select Open Backpack to view its contents. 
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Additional Support – Online Help, Techniques, and Tooltips

The Techniques Panel

Students can refer to the Techniques whenever they cannot remember a technique that was
described in one of the Tutorials or to find a technique that they need for a specific
project. The Techniques panel is located on the right portion of the Command Center. It
contains hundreds of useful MicroWorlds EX techniques.  If the panel is not displayed, open
it by selecting Techniques in the View menu.

The opening page of the Techniques panel contains a table of contents that lists all the
Technique topics. Select any topic and its sub-menu is displayed. If necessary, enlarge the
Techniques panel by dragging the side or top of the panel. For more information, refer to
the Overview – The Techniques Panel in the Advanced Reference Guide.

MicroWorlds EX Tooltips

Tooltips for all primitives are available as an additional aid to students as they work. To
access a tooltip, hold the mouse on any primitive in the Command Center or in a Procedures
tab. After a couple of seconds, the tooltip appears. The tooltip includes the following
information for that primitive:

• Number and type of inputs required, if any

• A brief definition

• A syntactical example showing the primitive with sample input(s) 

The tooltip closes after several seconds.



MicroWorlds EX Online Reference Guides

MicroWorlds EX program includes both a Basic and an Advanced (Comprehensive) Online
Reference Guide. Each of these guides contains a description of the various MicroWorlds EX
features and concepts as well as vocabulary definitions. The Advanced (Comprehensive) Reference
Guide contains all the information that is in the Basic Reference Guide plus additional vocabulary
definitions and information about more advanced programming concepts and techniques  It’s a
good idea to have your students first look in the Basic Reference Guide to find the information
they need. If they cannot find it there, they should then try the Advanced Reference Guide. 

MicroWorlds EX Robotics also includes the Robotics Reference Guide. 
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Assessment

Observation

Observe students as they work. Listen to the language they use when they talk about the
ideas in these projects. Ask questions. 

You may want to check:

• Are students working randomly of have they organized the steps so that they can
proceed purposefully?

• Are students extending their vocabulary as they experiment and develop projects?

• Are students looking for new ways to explore an idea?|

Communication

Being able to describe clearly the nature of a problem is a good sign of a careful thinker.
Encourage students to be specific when they ask for help, not “It doesn’t work” but “I
wanted it to…but instead it… I tried… and this… but I still have trouble.” The solution
may be out of reach, it may be something momentarily forgotten, or it may be something
out of sequence. Nonetheless, the ability to be specific about a difficulty is important and
should be noted. It also makes it easier for you to help!

Discussions

Spend some time away from the computer discussing what the students are doing.
Encourage the sharing of ideas and strategies. Notice the language used as the work is
presented. Does it indicate understanding? What kind of words are being used? 

Computer Portfolio

Have your students create their own online portfolio of their work. Projects can be
annotated with their own observations. The portfolio should be examined in the context of
the process the student went through to produce it. Ask students why they selected the
projects that they included in their portfolios. 
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Journals

Another excellent way to assess student learning is by having your students keep journals
of their work. They give students a chance to express both their confusions and their
understandings and provide them with a place to reflect on their learning and their
learning strategies. This can be as simple a task as noting a problem to be solved later,
plans of attack, and notes on approaches tried. Other journals may include a continuous
narrative about the experience or record new concepts as they arise.  

Although paper journals can be kept, you may want to consider an online journal. Using a
tool such as Journal Zone™ gives students a chance to extend the exchange of ideas and
reflect on their learning. The online record that is created enables you to trace the
problem-solving process and not just see the end product.

Self-evaluation

Ask the students to write an evaluation of their own work. Make the evaluation a part of
the journal. 

A self-assessment allows for some reflective thinking. 
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Additional Ideas 

Classroom “Turtle Repository”

Learning repositories are being developed in many educational institutions around the
world. These contain small instructional segments (“objects”) that can be used in more
than one learning situation. As a class project, you may want to create a “turtle
repository” of student-created importable turtles. These could be available for anyone in
the class to use in his or her projects. Creating such a repository provides students with a
great opportunity to think about what type of use, design and programming makes a turtle
a good shareable object. Students should create an information template to include in the
Notes tab of each of these turtles, describing who the object creator is, when it was
created, why it was created, and any other information they think pertinent.  

Creating a Set of Special Clipart for Your Class

The Painting/Clipart palette contains three sets of built-in clipart that cannot be modified,
but you  can add an extra set of clipart. It could be clipart for a specfic project, special
clipart that your students have selected, or images that you think would be particularly of
interest to your class.

This operation must be done outside of MicroWorlds EX. Quit MicroWorlds EX before doing
the following.

Preparing the Right Setup

Locate the MicroWorlds EX application folder on your hard disk. 
If you have performed a typical installation, you will find it in the Applications folder on a
Macintosh computer and, on a Windows computer, in:

C:\Program Files\LCSI\MicroWorldsEX
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This folder contains the following subfolders:

Open the Graphics folder. 
It should contain the following subfolders:

If it doesn’t contain a Personal folder, create one. It must be located exactly here, in the
Graphics folder, with this exact name.

Note: DO NOT modify the contents of the other Graphics folders (Animation Background,
Singles). The Painting/Clipart palette will work unreliably if you alter their contents. Only
the Personal folder can be altered.

Adding your Personal Clipart

To add your personal clipart to the Painting/Clipart palette, simply drop .BMP files into 
the Personal folder. The file names become shape names in the Painting/Clipart palette.
You should use one word names, with no spaces. For example, if you have a file called
tent.bmp, the shape name will be tent.

The next time you start MicroWorlds EX, an additional button appears in the
Painting/Clipart palette. Click on it to see the images that you have added to the 
Personal folder.
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